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About InSight™
InSight is Ember’s integrated network debug environment, which ties together firmware and 
hardware components of Ember carrier boards, and InSight Desktop software:

• Ember carrier boards are test beds for developing and deploying a ZigBee application. 
The breakout board for the EM250 and EM260 provides a direct attachment to the radio 
communication module. It also contains components for prototyping and testing an 
embedded wireless application, such as a temperature sensor, two buttons, a piezo 
buzzer, two LEDs, and a 2" x 2" through-hole prototyping area.

• Ember radio communication module (RCM) offers a complete ZigBee wireless solution 
for development and deployment of a low-data-rate, low-power ZigBee application. The 
four-layer (FR4) RCM features the Ember EM250 or EM260 radio chip, a 2.4GHz, IEEE 
802.15.4-2003 SOC that runs the ZigBee-compliant EmberZNet stack.

• InSight Adapter (in earlier Ember releases, the emulator debug module) connects the 
RCM to the Ethernet. It collects network data over the InSight Port cable connection and 
conveys it over its Ethernet connection to InSight Desktop. It also delivers messages and 
new software that are addressed to the RCM or its breakout board.

• InSight Desktop is a graphical tool that displays network and node activity in real time.

For detailed information about the EM250 and EM260 breakout boards, and InSight Adapter 
and InSight Port, refer to their technical specifications.

Licensed editions
Depending on your license, you have one of the following InSight Desktop editions:

• Professional Edition provides unlimited access to all InSight Desktop features and func-
tionality.

• Developer Edition provides access to all InSight Desktop features. This edition allows up 
to three adapter connections, and a maximum of 10,000 events in any given capture 
session.

For more information about obtaining and installing an InSight Desktop license, see the next 
section. 
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Obtaining a license
When you install InSight Desktop, you initially have a trial license that is good for 30 days. 
The following directions tell you how to obtain a permanent license.

After you install InSight Desktop...
Immediately after you install InSight Desktop, follow these steps:

1. Start InSight Desktop.

2. Choose the menu option File | Preferences

3. Choose Licensing

4. Copy the Node Key value and paste it into the body of an email message to 
support@ember.com. The message should also contain:

ISD license request in the subject line

Your company’s name in the message body

After you receive the license file...
After you submit your request, you should receive a license file from Ember support within 
one or two business days. After you receive this file:

1. Save the license file to your hard disk.

2. Start InSight Desktop.

3. Choose the menu option File | Preferences

4. Choose Licensing

5. Click Browse and navigate to the license file.

6. Open the license file.

7. In the Licensing dialog, click OK
InSight Desktop User’s Guide 120-4005-001D

mailto:support@ember.com


InSight Desktop features | 3
InSight Desktop features
InSight Desktop provides a rich and flexible interface to Ember embedded networks, which 
helps you develop and debug new network applications. InSight Desktop includes these 
features:

• Multiple editor panes that provide tiered views of network activity, letting you drill down 
from a high-level map of node interactions to the details of each packet. 

• Customizable filters that let you specify exactly which network activities to display.

• Log files that save captured data, so you can step through transactions and events for 
detailed analysis.

• A file browser that lets you easily upload new applications to any connected node.

• A browser-based interface for automatic discovery of Ethernet-connected adapters, and 
easy management of adapter applications.
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Quality of network data
The types of network activity that InSight Desktop obtains from an Ember node depends on its 
radio chip and InSight adapter. Depending on the development kit, Ember nodes support one 
of the following radio chips:

• EM250/EM260

• EM2420

Both are accessible to InSight Desktop, and relay information about debug applications. Their 
differences are detailed in the following sections.

EM250/EM260
The EM250 and EM260 radio chips provide special hardware and firmware for collecting 
network-level debug information. Their packet trace circuit acts like an on-chip sniffer and 
relays all packets that the RCM sends or receives, regardless of the application that is running 
on it.

EM2420
The EM2420 has two versions of InSight Adapter, which determine its data delivery capabili-
ties:

• 0221: When the RCM is running a sniffer application, all radio packets are relayed to 
InSight Desktop.

• 0222: All radio packets are relayed to InSight Desktop, whether or not the message 
passed the CRC check. Messages that fail the CRC check are shown by InSight Desktop in 
the Event panel; however, because their content is considered corrupt, InSight Desktop 
does not provide decoded content.
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Navigating InSight Desktop
The InSight Desktop environment contains the following work areas:

• Adapters view lists all adapters and their nodes that are accessible to InSight Desktop.

• Capture sessions contain data captured from a node or set of nodes.

• Editor panes display the data of a given capture session.

Adapters view On startup, InSight Desktop automatically discovers and lists all InSight adapters that are 
connected to the local subnet. You can also configure InSight Desktop to discover InSight 
adapters on other subnets.

Default and custom groups
When you first start InSight Desktop, it displays in a single default group all InSight adapters 
that are discovered by InSight Desktop. You can create custom folders and move InSight 
adapters to them:

Adapter details
You can expand each InSight adapter to display the following details about it:

• IP Address and Adapter Name identify this InSight adapter.

• Software Version shows which version of InSight Adapter is running on this adapter.

• Last Connect IP shows the IP address of the last InSight Desktop host to connect to this 
InSight adapter. 

• In Use is set to true or false to indicate whether another user is connected to this InSight 
adapter. If the adapter is in use, a lock icon appears next to it. Only one instance of 
InSight Adapter can be connected to an adapter at any given time. If you connect to an 
adapter that is in use, the previous user is automatically disconnected.

• Board Type identifies this adapter’s platform.

• Last Upload identifies the application that you last uploaded to this adapter’s node. If 
another user uploaded an application to the node, or if InSight Desktop is unable to iden-
tify the application for some other reason, this field displays Unknown.

Capture sessions InSight Desktop can display one or more capture sessions. Each capture session displays the 
data captured from one or more nodes. The captured data is shown in one or more editor 
panes. 

InSight Desktop supports two types of capture sessions:

• Live sessions display data as it is captured; the display is continuously refreshed as new 
data arrives. InSight Desktop maintains one live session at a time; when it starts, the live 
session is unnamed, and its data is maintained in temporary storage until you save it to a 
named file.

NOTE: Custom folders have no functional impact on adapters or their interaction.
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• Saved sessions contain captured data that has been saved to permanent storage in a 
named .isd file. You can load a saved session and play it back at any time.

InSight Desktop displays each session with its own tab. The tab of each saved session is 
labeled with the session’s file name; the live session is labeled Live.

When you start InSight Desktop, it opens a new live session and any saved sessions that were 
displayed when you last exited.

Editor panes Editor panes display different views of capture session data. Up to five editor panes can be 
open at any one time:

• Map provides a graphical view of the network, where nodes are displayed with their 
network identifiers. The map also displays network activity.

• Transactions displays high-level node interactions that might comprise multiple events.

• Events displays information about all packets transmitted and received during a capture 
session.

• Event Detail displays the decoded contents of the packet that is currently selected in the 
Events pane.

• Hex Dump displays the data of the selected event in raw bytes. InSight Desktop high-
lights bytes that map to the data currently selected in the Event Detail pane.
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Interacting with InSight Adapters
The following sections discuss the adapter actions that you can initiate and control through 
InSight Desktop. These actions are accessible through the context menu that you invoke by 
right-clicking on selected InSight adapters or an adapter group.

Most commands can be issued to multiple adapters simultaneously. You can select multiple 
adapters in one of two ways:

• Select individual adapters:

For contiguous selections, Shift+Click

For non-contiguous selections, Ctrl+Click

• Select one or more adapter groups to select all adapters within those groups.

Connect
In order to interact with any adapter, you must establish a connection between it and InSight 
Desktop. When you connect to an adapter, InSight Desktop opens the TCP/IP socket connec-
tions that it requires in order to communicate with InSight Adapter.

When you disconnect InSight Desktop from an adapter, it closes the TCP/IP socket connec-
tions. If any capture is in progress from that adapter’s node, it stops the capture first.

Make into a Sniffer
The node of any adapter that InSight Desktop is connected to can be designated as a sniffer. 
A sniffer node is capable of capturing all data that is transmitted among nodes over the desig-
nated channel.

A sniffer node must have a sniffer application loaded on its RCM:

• If no sniffer application is currently loaded, InSight Desktop prompts you to select an 
application that is compatible with this node. It uploads your selection to the RCM.

• If the node already has a sniffer application, InSight Desktop asks whether you wish to 
upload a new sniffer application. If you reply no, InSight Desktop activates the node as a 
sniffer with the current sniffer application.

After you designate a node as a sniffer, you can start using it to capture network data.

NOTE: Information about capturing network data from an adapter’s node is discussed 
separately.

NOTE: Before you connect, disable the Windows Firewall in order to allow connections to 
ports 4900-5000.
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Upload Application
Upload Application lets you upload an application to the node of the selected adapters. If 
uploading to an EM2xx node, InSight Desktop checks whether any application upload prefer-
ences are set. 

If you upload to an EM260 node, InSight Desktop displays a dialog that asks you to choose 
between two possible upload targets:

• Upload Host Processor lets you upload an application image to the host microcontroller.

• Upload Network Co-processor lets you upload a new image to the EM260 network 
co-processor.

Reset Node
If a node is in an inconsistent state, you can reset its RCM with this command, which pulls 
down its reset line for a millisecond.

Power Node On/Off
You can power on or off any connected node from InSight Desktop. If you are capturing data 
from that node, the capture is suspended, and resumes when the node powers up again. 

Reset InSight Adapter
This menu option resets the TCP/IP socket connections that InSight Desktop created when it 
connected to this adapter.

Upload Adapter Firmware
Use this option to upgrade InSight Adapter firmware.

CAUTION! Be sure that the application you upload is compatible with the architecture of 
the target node. For more information, refer to Application Note 5022, Programming and 
Using the Application Bootloader.
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Capturing and saving data
You can capture data from the node of any connected InSight adapter: from one node at a 
time, or multiple nodes simultaneously. You can also capture all network traffic over the 
current channel by capturing data from a connected sniffer node.

To start a capture:

1. Select one or more connected adapters.

2. Right-click on the selected adapters.

3. From the context menu, choose Start Capture

Capturing from a sniffer 
node

A sniffer node has a sniffer application loaded on its RCM, which enables it to capture all 
over-the-air transmissions between nodes over the designated channel.

When you start capturing from a sniffer node, it captures all packets that are exchanged by 
the nodes on the designated channel.

To discover available networks:

1. From the InSight Desktop toolbar, click the Channel/PAN button.

2. Select a sniffer node from the drop-down list and click Scan.

The selected sniffer scans all channels for networks that are within range, and lists their 
PAN ID and channel.

3. Choose a network from the list and click OK.

4. From the Adapters view, select the adapter of a sniffer node and from its context menu, 
choose Start Capture.

Capturing from multiple 
nodes

You can capture data from multiple nodes simultaneously. This is typically done for nodes 
that belong to the same network.

To capture from multiple nodes:

1. Select the corresponding InSight adapters from the Adapters view:

For contiguous adapters, Shift+Click

For non-contiguous adapters, Ctrl+Click

2. Right-click on the selected adapters.

NOTE: The types of data that are captured from a node depends on the capabilities of its 
radio chip and InSight adapter.

NOTE: If you select a node that is not a sniffer, InSight Desktop asks whether you wish to 
upload a sniffer application to it.
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3. From the context menu, choose Start Capture

Alternatively, you can start a capture from all InSight adapters within a group, provided all 
adapters in the group are connected: right-click on the group folder and from the context 
menu choose Start Capture.

Perfect trace sessions
With the EM250/EM260 and EM2420/0222 platforms, InSight Desktop captures all incoming 
and outgoing packet data via the selected adapters, whether or not the host nodes have 
sniffer applications. The data includes failed transmissions, and debug messages from node 
applications that are compiled in debug mode.

Capturing from all nodes in a network yields a perfect trace session: the session data 
compiles all incoming and outgoing data from each node in chronological real time, providing 
a richly layered view of all activity within a network. This can be especially useful for debug-
ging a network while it undergoes development.

Viewing captured data All captured data is continuously updated and displayed in the following editor panes:

Map
The Map pane shows all interaction between nodes at a high level. Each node is represented 
by an icon. As events occur or are replayed, the map pane refreshes to show the pattern of 
network communication.

Transactions
The Transactions pane displays all event transactions. For example, all events that pertain to 
a node joining a network are regarded as a single Associate transaction. These events include 
all requests and replies that are sent by the node offering permission, and the node petition-
ing to join.

All transactions are listed in chronological order, using transaction start times. Each selection 
is marked and maps to one or more events in the Events pane, which are marked accordingly. 
All transactions and their events are numbered sequentially.

NOTE: A sniffer capture intercepts all over-the-air transmissions among network nodes; 
however, the sniffer cannot detect any data transmissions that are known only to their 
senders such as messages that fail to arrive at their destination, and debug data such as API 
traces.

NOTE: If you have filters turned on, number gaps are likely to occur.
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If transactions overlap, the Events pane uses clock icons to mark unrelated events that are 
concurrent with the selected transaction: 

Events
The Events pane displays information about packets received by the current session. All 
events are displayed in chronological order. Events that belong to a transaction are marked 
by one of the following icons:

Event Detail
The Event Detail pane displays the decoded contents of the packet that is currently selected 
in the Event view. The content of this pane varies according to the packet type.

Hex Dump
The Hex Dump pane displays the data of the selected event in raw bytes. InSight Desktop 
highlights those bytes that map to data selected in the Event Detail pane.

Clearing a session Clear Events purges all events and their associated transactions from the current session. 
Unless previously saved to a session file, cleared events cannot be retrieved. 

Stopping a capture Stop Capture ends the flow of network data to the current session. Start Capture resumes 
capturing to the live session.

Transaction icon Meaning

Start of transaction

Intermediate event.

End of transaction

Single-event transaction
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Saving a session When you start a capture, it is initially written to an unnamed live session. At any point 
during a live session, you can save the data thus far captured to a file by choosing the menu 
bar option File | Save. After you save a session file, InSight Desktop continues to append 
capture data to it; however, you must save again in order to retain this data in the session 
file.

InSight Desktop closes a saved session from further captures after you explicitly stop the 
capture, or when you start another live session. After a saved session is closed, it cannot be 
reopened to capture more data.

If you modify a saved session file—for example, set bookmarks or reposition icons in the map 
pane—InSight Desktop asks whether to save or discard those changes before you close the 
session.

Multiple save
If multiple open sessions have unsaved data, you can save all of them at once by choosing 
File | Save All.

Session file data
InSight Desktop saves session data to an .isd file, which is a compressed file that stores 
session data and the network state. Network state includes display settings such as map 
modifications, which InSight Desktop restores when you reload the session file.

Open and close options
You can open any session file and review its contents by choosing File | Open and browsing 
to the desired file. For fast access, choose a recently viewed file from the File menu.

InSight Desktop provides several options for closing sessions:

• To close a single session, click on the session tab’s close control.

• To close all sessions, right-click on any session tab and from the context menu choose 
Close All. Alternatively, choose the menu bar option File | Close All

• To close all sessions except the current one, right-click on its session tab and from the 
context menu choose Close Others.

Replaying a session
You can replay events of the current session, whether live or saved, by choosing 
Edit | Start Replay. InSight Desktop starts replaying the session from the selected event. 
Events are replayed at a constant speed. Replaying events in a live session has no effect on 
the capture in progress.

To stop the session replay, choose Edit | Stop Replay

Navigating a session InSight Desktop provides several navigation tools that help you navigate through the current 
session:

• Edit | Lock to Bottom locks the cursor on the latest event during a live session. To break 
the lock, select any event or transaction.

• Edit | Go to Line moves the cursor to the specified line number.
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• Edit | Go to Time moves the cursor to the transaction and event that match or immedi-
ately follow the specified time.
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Filtering captured data
By default, the Events pane displays all session events. You can build and apply filters that 
constrain InSight Desktop to show only those events that are of interest. By including only 
events that are of interest, you can analyze results more efficiently.

You apply filters to each session individually; so different sessions can have their own filter 
settings. When you change a session’s filters, InSight Desktop immediately refreshes the 
display. When you exit InSight Desktop, all session filters are cleared and must be reapplied 
when you restart.

Filter editors
InSight Desktop provides two ways to edit filters:

• Filter Manager: Maintains a set of saved filters that you can review and edit. You can 
also add new filters. You specify any of the saved filters for display on the Filters menu, 
where they are accessible for use in one or more sessions.

• Filter Bar: An editor that attaches to a given session, where you can enter one or more 
filter expressions on the fly. InSight Desktop discards filter bar expressions for all 
sessions when it exits.

Quick filters
InSight Desktop also provides several preset context-sensitive quick filters that are available 
from the Transactions and Events editor panes. 

Filter Manager The Filter Manager lets you perform the following tasks:

• Compose filter expressions with the expression builder.

• Use filter expressions to customize display of entries in the Events pane.

• Specify which filters appear in the Filters menu.

Building filter expressions
The Filter Manager provides an Expression Builder that provides a built-in set of valid oper-
ands and operators that you can use to compose filter expressions. You can also enter expres-
sions manually. In both cases, Expression Builder validates entries as you work and prevents 
you from setting invalid expressions.

To use Expression Builder:

1. Select a filter from the Filter Manager list, and click on the filter expression 

2. Click on the ... control.

3. Choose the required operands, operators, and values. You can use logical operators such 
as && and || to specify multiple conditions, and parentheses () to group expressions and 
set precedence.

4. Click OK
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Maintaining filters
In order to add a filter to the Filters menu, set the Menu checkbox. This makes the filter 
available to the current sessions. 

You can also add, delete, and rename saved filters. In order to restore filters to their instal-
lation settings, click Reset. 

Setting filter color schemes
You can associate a color scheme with each filter. If an event evaluates to true for a given 
filter expression, InSight Desktop applies the filter’s color scheme to that event. An event can 
be configured with a color scheme for two display levels:

• In the Map pane, the color used by the graphic representing the event type.

• In the Events pane, the foreground and background colors used by event type instances. 

To set a filter color scheme:

1. In Filter Manager, click on the filter expression item.

2. Set the color of the Map pane graphic, and foreground and background colors of event 
instances, by clicking on each one’s ... control

3. Click on the Color checkbox to determine whether to use this color scheme.

4. Set the color scheme’s precedence level by assigning it a positive or negative integer. If 
an event evaluates to true for multiple filters, InSight Desktop uses the color scheme 
with the highest precedence.

5. To refresh the Map and Event panes with the new color scheme. click Reapply.

Filter Bar A session’s filter bar provides the same level of functionality as the Filter Manager for build-
ing expressions. Any filter expression that appears in a session’s filter bar is AND’d with the 
saved filter expressions that are already in effect for that session. 

You can compose a filter bar expression in two ways:

• Enter the expression directly in the filter bar field, and press Return.

• Use the Expression Builder by clicking Compose

Quick filters InSight Desktop provides several filters that are available from the Transactions and Events 
editor panes. You access these filters by right clicking on an event or transaction and choos-
ing a context menu option. 

The filter options that are available depend on the transaction or event that you select. You 
can specify to hide all events/transactions of the selected type, or to show only that type. 
For example, if you select an event of type APITrace, the context menu displays two filter 
options:

NOTE: Setting a color scheme on a filter expression does not specify whether to display 
events; it only determines how to display certain event types.
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• Hide type: APITrace

• Show only type: APITrace

Further, if you select an event such as a neighbor exchange that has a source and/or destina-
tion address, the context menu also contains these two filter options:

• Show only destination: short-ID

• Show only source: short-ID

In all cases, InSight Desktop enters the corresponding filter expression in the session’s filter 
bar. For example, if you specify to show only route discovery transactions, this expression is 
set in the filter bar:

isType(Route) 

NOTE: When you choose a quick filter, its expression overwrites any previous filter bar 
expressions.
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Customizing InSight Desktop
You can customize the look and feel of InSight Desktop to suit your work habits and prefer-
ences. Customization features also can help you work more effectively. The following 
sections show how to:

• Create InSight adapter groups

• Customize editor panes

Creating InSight 
adapter groups

When newly installed, InSight Desktop shows all InSight adapters within a single default 
group. You can group adapters logically under folders that you create. For example, your 
application might have different types of sensor nodes, and various sink nodes for each type. 
In that case, it makes sense to group the adapters of similar nodes under a folder that you 
name. This can help you remember which applications are running on those nodes.

You can also use custom groups to issue commands and upload applications to multiple adapt-
ers and their nodes. Any command to the group is broadcast to all adapters within it. Simi-
larly, an application that you upload to a group is uploaded to all its adapters.

Creating a custom group
To create a custom group:

1.  From the Adapters toolbar, click Add Group

InSight Desktop creates a new folder New Group.

2. If desired, rename the New Group folder:

Select the folder name.

Type the folder’s new name, then press Enter.

3. Click on a node to be moved and drag it to the new folder. For multiple selections, use 
Shift-Click and Ctrl-Click for contiguous and non-contiguous selections, respectively.

Removing a group:
When you have no further use for a group, you can remove it as follows:

1. In the Adapters view, right-click on the folder to remove.

2. From the context menu, choose Delete

InSight Desktop removes the group folder and moves its adapters to the default group.

Customizing editor 
panes

InSight Desktop provides a number of customization options that let you change the appear-
ance of the editor’s map, transaction, and event panes:

Map pane
You can move node icons within the map display. This has no effect on network functionality; 
however, it can help to highlight certain node interactions and relationships. When you move 
node icons in a session, InSight Desktop asks whether to save those changes before you close 
the session.
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The following Edit menu options let you customize the map pane’s appearance and behavior:

• Show Connectivity shows the routes that nodes use to communicate with each other. 

• Show LQI toggles display of link quality data that pertains to the quality of connection 
between nodes. 

• Node identifier toggle options help identify nodes:

Show Short ID toggles display of the node’s 16-bit address that is unique within the 
personal area network (PAN)

Show EUI64 toggles display of the node’s unique 64-bit IEEE address

Show PAN ID toggles display of the PAN identifier of the node’s network. This label 
can be useful when the map displays multiple networks.

Show Node Label displays the custom label that you create for map display only.

• Zoom Map In and Zoom Map Out enlarge and shrink the space that the map uses to 
display nodes. Zoom options have no effect on the size of node icons.

• Load Background Image lets you display a background image in the map pane.

Node display options
When you select a node icon in the Map editor, the following display options are available 
from its context menu: 

• Assign EUI64 lets you assign a EUI64 to a node. InSight Desktop obtains a node’s EUI64 
only when that node associates with a network. If the node already belongs to a network 
when a session begins, its EUI64 is unknown to InSight Desktop. This option lets you 
display a known EUI64 for a node; the node’s actual EUI64 is unaffected by this label.

If InSight Desktop obtains a node’s EUI64, this option is unavailable.

• Label By default, the map pane labels each node that is undergoing capture with its 
adapter (device) name. This option lets you customize the node’s label with any string up 
to 25 characters long. This string appears in brackets after the node’s device name.

You can also make the labels time-dependent, by entering a start time. This lets you 
supply multiple names for the same node. This can be useful while debugging applica-
tions, by indicating the node’s current state.

• Icon provides a menu of defined icons to represent the selected node. 

• More Icons invokes the Node Icons dialog. 

• Color provides a palette of available colors. You can apply one of these to the node icon.

Transaction and event panes
The following Edit menu options let you customize the appearance and behavior of the trans-
action and event panes:
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• Simultaneous Events modifies the map pane to display all events that occurred at the 
same time as the transaction or event that is currently selected. 

• Apply Row Coloring toggles filter color definitions on and off.

Bookmarks
You can set a bookmark on any event as follows:

1. Right-click on the event.

2. From the context menu, choose Add bookmark

3. In the Add Bookmark dialog, supply a name and time for the bookmark:

The bookmark name can be any string.

The bookmark’s time is initially set just before the selected event. You can change 
this to any time that precedes or follows existing events or bookmarks.
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Reconfiguring the Work Area
You can rearrange InSight Desktop’s physical configuration to suit your work habits and pref-
erences. For example, you can reposition the Adapters view, or resize editor panes. You can 
also restore the startup configuration by choosing the menu bar option 
Window | Reset perspective.

Manipulating views The InSight Desktop work environment has two views: Adapters and Filter Manager. When you 
first open InSight Desktop, it positions these views as follows:

• Adapters view is on the left

• Filter Manager is hidden. When initially invoked, InSight Desktop places it on the bottom.

You can perform the following actions with views:

You can reposition a view anywhere on the working area’s perimeter that is not occupied by 
another view. Four positions are possible, as shown in the following figure:

To reposition a view, click on its title bar and drag to the desired position.

Resizing and hiding views
Each view has the following controls:

• Maximize expands the view to encompass the entire working area. 

• Minimize shrinks the view to a narrow strip.

• Close removes the view from the working area. You can restore a closed view by select-
ing it from the Window | Show view menu.

• Restore resets the view to its dimensions before it was minimized/maximized.

You can manually resize a view by dragging its inside border in and out.

Using fast views
You can designate the Adapters and Filter Manager views as fast views. When you do so, 
InSight Desktop anchors the view to a fast view icon, which can be toggled to display or mini-
mize the associated view.

vert/left vert/right

horiz/top

horiz/bottom

NOTE: While the Adapters and Filter Manager views can both be designated as fast views, 
only one can be active as a fast view at any given time.
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To create a fast view:

1. Right click on the view’s title bar.

2. From the context menu, choose Fast View. InSight Desktop minimizes the view and 
associates it with a fast view icon that displays on the Fast View bar.

Alternatively, drag the view to the Fast View bar.

When you restore a fast view, it restores its previous orientation—vertical or horizontal. To 
change the current orientation, right click on the view’s title bar and choose an Orientation 
option.

Using tear-off views
Any view can be removed from the main window so it floats freely.

To create a tear-off view:

1. Right click on the view’s title bar.

2. From the context menu, choose Detach. InSight Desktop detaches the view from the 
main window.

Modifying editor panes The relative positions of editor panes are fixed. However, you can change their dimensions in 
two ways:

• Resize an editor pane by dragging an inside border.

• Click the editor pane’s resize control. Depending on the pane’s current state, this 
control toggles between Maximize and Restore. 

NOTE: A view can be either a tear-off or a fast view, but not both.
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Setting Preferences
You can set general preferences for InSight Desktop that apply to all capture sessions. InSight 
Desktop saves these preferences and uses them each time it restarts.

Application Upload
The Ember installation sets the Windows registry with default paths to the application loader 
and bootloader image, which InSight Desktop uses when it uploads applications to EM2xx 
nodes. Use this Preferences dialog to specify different locations:

Application loader path specifies the loader utility that is used to upload bootloader or 
application images to EM2xx nodes. Set this field by browsing for another application loader.

Bootloader image path specifies the bootloader application that is uploaded to an EM2xx 
node when you upload an application image. The bootloader application is uploaded depend-
ing on the status of Always Upload Bootloader Image:

• Always Upload Bootloader Image is checked: the node is refreshed with a new bootloader 
image whenever you upload an application.

• Always Upload Bootloader Image is unchecked: the bootloader image is uploaded only if 
no bootloader image is present on the node.

You can upload the installed bootloader image, or you can browse for a different one.

Decoding
Decryption key: Key used to decrypt security-enabled packets.

Security level: The security level set for the MAC and network layers:

• 0x00: No security.

• 0x05: Payload is encrypted and a 4-byte MIC is used for authentication.

• 0x85: Payload is encrypted and the MAC header is always authenticated. This setting is 
not defined by the ZigBee standard.

Packet decoder mode: Specifies the version of the EmberZNet or Embernet stack that is 
used. Auto-detect can detect most stack versions except Embernet 3.3.

Ignore security flag: If set processes any packets that have their security flag turned on, 
whether the contents are encrypted or not. 

Custom decoders: specifies which custom decoders to use. If enabled, custom decoders 
provide an extra layer of decoding for application-level data.

Adapter Discovery
InSight Desktop searches for all InSight adapters to display according to the settings in the 
Discovery Preferences dialog, accessed from File | Preferences | Discovery. 

InSight Desktop, by default, scans the local subnet for adapters. However, you can configure 
InSight Desktop to find adapters on other subnets with this format:
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subnet-ip-address/mask-address

For example: 192.100.5.0/255.255.255.0

File
Check Monitor files for appending after opening if you wish to enable InSight Desktop to 
detect new packet data appended by an external program to an open session file, and read it 
in for display.

Help
Specify whether to open up help in an Eclipse window or an external browser.

Licensing
In the Licensing dialog, you can obtain information about your InSight Desktop license; and 
you can reset your license key. License keys are provided by Ember customer support. 

Node Icons
The Node Icons dialog displays all icons that are available for customizing display of nodes in 
the map pane. InSight Desktop provides predefined several icons. You can also add icons of 
your own. 

Stream
You can configure how InSight Desktop handles incoming data for capture sessions with these 
options:

Maximum number of cached events: specifies how many events can be displayed in a live 
session. When you exceed this limit, InSight Desktop removes the earliest events from the 
cache and no longer displays them.

Sorting and duplicate match window: Specifies in microseconds a time span in which dupli-
cate packets can be detected. If identical packets arrive within the specified time span, 
InSight Desktop detects the duplication and allows only one to display.

This setting also determines how events are sorted. In general, events are reported in chrono-
logical order. In the event that packets are received out of order, InSight Desktop uses this 
setting as follows:

• Events that arrive within the specified time span are sorted chronologically. 

• Events that arrive after the specified time span display out of chronological order.
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